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NATE D

Davsic Jolid /"\odtling

Basic Solid Modeling di s |
Extrude Options

- Upon successful completion of this lesson, you will be able to:
* Sketch on planes and/or planar surfaces.
* Use sketch tools to construct geometry.
* Add geometric relations or constraints.
* Add/modify dimensions.
* Explore the different extrude options.
- The following 5 basic steps will be demonstrated throughout this exercise:

* Select the sketch plane.

* Activate Sketch pencil e :

* Sketch the profile using the sketch tools N © ?'I :

* Define the profile with dimensions %4 or relations b .

* Extrude the profile = :

- Be sure to review self-test questionnaires at the end of the lesson, prior to
going to the next chapter.
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Basic Solid Modeling
Extrude Options

Dimensioning Standards: ANSI
Units: INCHES — 3 Decimals

Insert Sketch

Add Geometric
Relations

Tools Needed:

N

%4

Line

Dimension

Boss / Base
Extrude

@ Circle

+] Sketch Fillet
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1. Starting a new Part:

- From the File menu, select New / Part.

(]~ Solidworks Search )i

)|
=
|
=

- Select the Part template from either the Templates or Tutorial folders.

New Solidworks Document 7%

-:,\\/ % 4 30 representation of a single design cormponent

Part

@ a 30 arrangement of parts andfor other assemblies

Assembly

a 20 engineeting drawing, typically of a part or assermbly

Crrawving

dvanced | pr——— pom— Help

- Click OK [__8&__|; a new part template is opened.
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- The next step is to set up your system options.

Q@solidWorks Tools O-@-d-%-9-8 8- Partl 2.~ 8%
DR EHB®[&]9 ¢ [B |oewcowre. e i@f8086@0es | Saadagsud 80063080 |
e DO Sf My | DriveWorkspress... o .
seth smat |0~ - @ - Al 7 | G| pempress Pattern - | Display/Delete Quick
Dimension Entities Relations Snaps
- - @ N ~ B | cosmosipress... - 2 £
m : B 5 ropes.. RARC WD B oo - B -3
FRlee ~» ) soect
o ) IR [ nvert Selection
@ Partt
B @ Rnrrtatione ] Sketch Entities »
3= Material <not specified> Sketch Tools 2
% Front Plane Sketch Settings >
& Top Plane. Blocks >
& Right Plane Spline Tools >
L, orign Dimensions »
Relations »
Measure...
5 [ Mass Properties,
‘Section Properties...
Check.,
Feature Statistics. ..
Equations...
Undercut Detection.
3 | Import Diagnostics... J&
4 Deviation Analysis..
Dimipert >
Macro »
Add-Ins....
= Customize. ..
Options....
Customize Menu
Model [ 1
Changes options settings For SolidWorks. [T EdtingPart || 2 ) \

2. Changing the Background color:
- Select Tools / Options / Colors.

- Under Background Appearance, select Plain (Viewport Background Color),
and choose the White color if not yet
selected (arrows).

System Options - Colors

x.

System Optians | pocument Properties |

General
Drawings

Display Seyle [ o ok | . .
-:’\>m/ - This will change your background

Sketch
Relations{Snaps

Display/Selection

Performance

asserbles

External References

Defaulk Templates

Current color scheme:

Top Gradient Color

Euttuvaad\en;Cu\ur Color tO White.

File Locations Selected Ibem Missing Reference

i Seected Face, shaded =l

View LN Use document scene background . 4
BackupretDvst: & Plain (¥iewport Background color above) Basic colors:

Hole wizard|Tool T " Gradient (Top/Bottom Gradient colors above) - l_

File Explorer " Image file:

Search e —
Collaboration smake.png

Advanced Reset Al TaDefouts | Seve ds Scheme... |

IV Use specified color for Shaded With Edges made:
[V Use specified colors when editing patts in assembiies

IV Use specified color for drawings paper colar (disable image in sheet background) L
o To Dot Colors L B

(=]
&
2
g
3
Q
2
g
E

Hue:[160  Fed: [255
[ - sel e

Resst Al Define Custom Colars > I Colorl3oid | | lm Elue: IE
oK | Cancel Help ak. I Cancel | Add ta Custom Colars |
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3. Starting a new Sketch:

Ve et O -3 -5-9- L8
@ml afh !‘iu ydi\ + ﬁﬂgﬁ@@[@ﬁu‘i‘w\ ¥ AR D b

patl T

& BoOEd ans

- Select the Front
plane from the
FeatureManager

T *

tree and then
click the Pencil

icon E to open
a new sketch.

[T TEdngrart [T T

- From the Command-

QSolidWorks ¢ Fie Edt v Wo-2-0-%-9- |

:

DRHEDS]9 8- |Im|1 T QV{ i1 @88

Manager toolbar,
select the

N

Line

OPTION:

from it. (See th

Mouse Gesture

- Position the mouse cursor

at the Origin point, a

yellow feedback symbol

pops up to indicate that
a relation (Coincident)
is going to be added
automatically to the

1** endpoint of the line.

2
v 9 @ A Trim  Convert Offseti Linear Sketch Pattern ~ | Display/Delete Qui
Entities Entities Entities ... Relations Sna
Yo Move Entities - 2

Dimension

Skee.t&‘ 0 .' @ f\J v i as A Mirror Entities l"‘

Command Manager
Toolbar

Right-Drag to display the Mouse Gesture guide and select the Line command

e Introduction section, page XVIII for details on customizing the

Mouse Gesture).

.Frorw’r Plane

VAR

Auto-Relation
feedback symbg

—_—
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4. Using the line command:

- Click on the Origin point and hold the mouse button to start the line at
point 1, drag upwards to point 2, and then release the mouse button.

2

Start the line from Point 1
and drag to Point 2

Front Flane

—

{@i:The Base Sketch

The Base Sketch is the
parent sketch of a part and
is also the very first sketch
in a part document.

It should mostly describe
the basic shape of the part,
before other features can
be added on to it.

- Continue sketching the other lines using the Click-Hold-Drag technique.

- The size and shape of the profile will be corrected in the next few steps.

3-6

Q System Feedback

While sketching the
lines, watch for the
System Feedback
Symbols such as &=
for Horizontal, and
for ]l Vertical Auto
Relation.
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5. Adding Geometric Relations*:

- Click J:I. under Display/Delete Relations - OR - select Tools / Relations /
Add.

- Select the 4 lines as shown below.

- Click EQUAL from the Add Geometric Relation dialog box.

w0 -2 --%-9- 8 B * Geometrip relat.ions are one of the mosF powerful
3a-p@w-E@ ‘ I @Re6E features in SodeO?ks. They’re used in ‘Fh.e sketch level
to control the behaviors of the sketch entities and to

& Mirror Entities ﬁt —_ . . .
258 |ineor Sketch Pattern < | Display)Belete | Quick keep them associated with one another. When applying
= . Relations Snaps . . . .
i Move Enties -\ geometric relations between the items, one of the items
— :>|j!i T Re""“°| should be a 2D entity and the other item can either be
elation . .
B [ Fully Define sketeh a 2D sketch entity, or a model edge, a plane, an axis,

or a curve, etc.

" Equal Relations Geometric relations can be gﬁi::g .
created manually or (RN vt :]

Adding the EQUAL automatically. The next steps  |[#| calinear 4

relations to these lines in this chapter will demonstrate |[X|paralel

eliminates the need to how geometric relations are = | equal

dimension each line. added manually. |E| =

Select the top 4 lines and
click Equal relation

The top 4 lines are
now Equal in size.
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6. Adding a Collinear relation**:

- Select the Add Relation J:I- command again.

- Select the 3 lines as shown below.
- Click COLLINEAR from the Add Geometric Relations dialog box.

- Click OK /).

Select the bottom 3 lines and
click Collinear relation

Add Relations

B

|:| Harizontal

|T| Werkical

B colinen

| > | Parallel

| Py

| = | Equal

(32

The bottom 3 lines are
moved to the same level.

_Q) Collinear Relations

Adding a Collinear
relation to these lines
puts them on the same
height level; only one
dimension is needed to
drive the height of all 3
lines.

** The Collinear relations can be used to constrain the geometry as follows:
- Collinear a line to another line(s).

- Collinear a line(s) to an edge of a model.
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Geometric Relations Examples

Coincident
] /

An endpoint is
Coincident with a line.

Midpoint
7 /

An endpoint is
Coincident with a
midpoint of a line.

Tangent

+ An arc is tangent with
a line or another arc.

Two circles are
sharing the same
center.

Concentric

Equal

Two lines are on the level
(or Co-planar).

[ | |
I & . .
Two circles or two lines
having the same size.
Collinear
Tangent
F
I
Two or more
TWO or more _ — points are
pqmts are ‘ aligned
Vertical aligned vertically. horizontally.
I
Horizontal
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7. Adding the horizontal dimensions:

- Select "5} from the Sketch toolbar - OR - select Insert / Dimension, and add
the dimensions as shown below (follow the 3 steps A, B and C).

QSolidWorks g Fie Edt view
ij)gfﬁ ,‘:"l@lk). & .
[e o |N-9- -

Sketch | Smart D'-S}'@'A
Di ;
b ,',",‘,evf‘s','?!‘, ® n S

ﬁ A. Click ling ———— o

B. Click line

x|
[.500 =]

| T T I o o o = 1 [ 1|
v|x|8[:2]&

C. Place the dimension o~
approximately here
and enter .500in.

- Continue adding the
horizontal dimensions
as shown here.

NOTE: 500
The color of the sketch lines

changes from Blue to Black,

to indicate that they have been ~——4.000
constrained with a dimension.

2000

6.500
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8. Adding the Vertical dimensions:

- With the Smart- ]
Dimension tool —1
still selected, click
on line 1 and line 2; Modify T
place the dimension | =&
. | TR NNENNNERRNNNREFTT TTT]
approximately as
shown, and change VX B8RP
the value to . 5
500 in. ' 496
500
A. Click line 1
-— 2000 —
4.000 B. Click line 2
&.500
- Continue adding
other dimensions 4.500
ulriltil Ilhe enti?e 3,500
sketch turns into
the Black color. T 230
| 1500
50 |
500
— 2000 =
4000 ————
4.500

The Status of a Sketch:

The current status of a sketch is displayed in the lower right corner of the screen.
|Fully Defined | [Editing Sketchz

Fully Defined = Black
Under Defined — Blue lunder Defined | [Editing Sketchz
Over Defined = Red ' Ower Defined || [Editing Sketchz
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— Sketch Relation
- /‘ Symbols**
-] /
B
EEs /
5 - i‘..a 4.500
m |m
m |m
A8 B oEgis W s
.lr B OE & B " & B
& !
& =
00— e
f—— 2 000 —=
4.000
&.500

A solidWorks  Fie edit (View ) Insert Tooks Window Help |

\D&l,d |&9- O

N-@-n
SkEtdﬂ Smart
DImEﬂSmﬂ

o-2-a

E)_\aoe
I_ﬂ |%¢O

ﬁpam
ll_l'“ izl

> Front Plane
} Top Plane
> Right Plane
Origin

..... E {-) Sketch1

Redran Chrl+R
Screen Capture

Display
WodiFy
Lights and Cameras

Hide All Types
Planes

Axes
Temporary Axes
Origins
Coordinate Systems
Curves
Sketches
3D5ketch

Grid

All Annotations
Foinks

Routing Poinks
Parting Lines
Lights

Cameras

3
3
3
3

% PR @’@@@@@@

Sketch Relations

A

of << <] <|E

Annotation Link Errors
Annotation Link Yariables

Fide / Show Bodies. .

Appearance Callouts

Toohars

Full Sereen Fi1
FeatureManager Tree Area F9
Toolbars Fi0
Task Pane

MotionManager

Status Bar

Customize: Menu

9. Hiding the Sketch Relation Symbols:

- The Sketch Relation Symbols indicates
which geometric relation a sketch entity
has, but they get quite busy as shown here.

- To hide or show the Sketch Relation
Symbols, go to the View menu and
uncheck the Sketch Relations option.

. Horizontal relation
. Equal relation

Bl Tangent relation

Sketch Relation Symbols at a Glance

. Coincident relation

¥ Collinear relation

. Vertical relation
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10. Extruding the Base:

- The Extrude Boss/Base command is used to define the characteristic of a
3D linear feature.

- Click ﬁ from the Features toolbar - OR- select Insert / Boss Base /
Extrude.

R e S o P IR [Covmmmne D 2o 8%
N © Swept Boss/Base 3 & ® & Swept Qut ;k W& R W wap ndl
oved Extuded Hoe Revolved Lnear ference. Curves | %0
} Lofted Boss/Base. oF P M Lofted Cut Patten & mn%m‘m |

1 Boundary oss/Bae ™ BoundaryCut . . M Shel /A mmor

-8 %

Qaved@-J-v-00-8-

@ PartIN (Default<D..

'm Boss-Extrudel ks

A

“Isometric

m Boss-Extrude v

¢ X & - Set the following:

[sketch Plane -]

- Direction: Blind.

—
Reversie\/. [Bing -]

” I - Depth: 6.00 in.
® - Enabled Reverse direction.

[ | praft outward

— i - Click OK ¢/).
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11. Sketching on a Planar Face: BB 0. A j} -
1 @feoasleds | s/aaq

- Select the face as indicated.

& B
E ~ | Display/Delete Quick = wric (CoieT)
1 Rela Snaps sometric ¥
- Cth or SGICCt Insert/SketCh' M : Pons n~p Rotates and zooms the model to the
D Ph at B isometric view orientation,
Qaa¥S P . =

- Click @ from the Sketch Tools toolbar
- OR - select Tools / Sketch Entity / Circle.

(From the View toolbar above the CommandManager, click the Isometric icon
or press the shortcut keys Ctrl+7).

()’ Planar Surfaces

Select the Sketch Face

- A planar surface of the
model can also be used as
a Sketch Plane.

- The Sketch will then be
extruded normal to the
selected surface.

- Position the mouse cursor on
the selected face, click and
drag outward to draw a circle.

- While sketching the circle,
the system displays the radius |
value next to the mouse cursor.
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- Select the Smart Dimension

command @ and add a
diameter dimension to the
circle.

(Click on the circle and move

the mouse cursor outward, at
approximately 45 degrees,
and place it).

- Continue adding the
location dimensions
as shown, to fully
define the sketch.

12. Extruding a Boss:

=

- Click

"0 Extrude Options...

Explore each extrude option to
see the different results.

Press Undo to go back to the
original stage.

Extruded
Boss/Base

oty IR
[2.000 ==
v X 82

2,250

or select Insert / Boss-Base / Extrude.

QiSolidWorks ¢ Fie Edt View Insert Toos Wdow Hep o[ ]
DREHED[2(9-@ - Bk 8| EHs- 5 e-

fx:'d Revolved Boss/Base % lia Revolved Cut

Extruded Hole
Cut Wizard

Lineal

Patter

Swept Boss/Base = Swept Cut Fillet

Lofted Boss/Base A Lofted Cut
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EEET
@ Using the Blind option: ¥ * &

—_—
- When extruding with the ol -
?11ilnd qption, ‘gl_e- [)"__‘ 'B"nd -
ollowing conditions | -]
are required: & I . R
ol I
* Direction [ Morge resut
D
* Depth dimension I Dot outward
- Drag the direction arrow on the preview graphics Blind
to define the direction, then enter a depth dimension Condition

to try out the Blind option.

Using the Through All ¢ % & -
option:
- When the Through All irecti —
option is selected, the (e Froush i L o

system automatically ” Il: . -
extrudes the sketch to the I marge resut

length of the part normal (@

to the sketch plane. I Drft cutmard
Through All
Condition
@ Using the Up To Next ¢ x &
option:
- With the Up To Next irect:

option, the system (2 [epToen =)

extrudes the sketch to 4 I

the very next surface, 7 Mergs result

and blends it to match @ —‘

the shape of the surface I Dreft outverd

whether it is a planar or

curved surface. Up To Next
Condition
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(D) using the Up To Vertex
i o K G
option:

- This option extrudes
the sketch from its plane
to a vertex, specified by

the user, to define its depth.

@ Using the Up To
Surface option:

- This option extrudes the
sketch from its plane to a
selected surface or a face
to define its depth.

@ Using the Offset From
Surface option:

- This option extrudes
the sketch from its plane
to a specified distance
from the selected face
or surface.

ISketch Flane 'l

W Merge result
@ |

[T Draft cutward

IUp To Werkex 'l

Select a
- / Vertex

Un To Vertex

|

¥ R G

ISketch Flare 'l

A, IUp To Surface 'l

¥ Merge result
@ ]

[T Draft cutward

¥ R G

ISketch Flane 'l

IOFFset From Surface 'l

B

I Reverse offset
™ Translate surface
V' Merge result

IT Draft outward

3-17

Up To Vertex
Condition

Select a
" / Surface

Up To Surface

Condition

Select a surface
to offset from &
enter a distance.

Offset From Surface

Condition
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@ Using the Up To Body option:

- This option extrudes the sketch from its sketch plane to a specified body.

Select a Solid Body
to extrude to.
(optional)

I Extrude 7

¥ R &
[from A
ISketch Plane 'l

. IUp To Body l

"l
-_=-||jEj 1>

W Merge result

@] 2

I™ Draft outward

Up To Body
Condition

- The Up To Body option can also be used in assemblies or multi-body parts.

@ Using the Mid Plane option:
- This option extrudes the sketch from its plane equally in both directions.

- Enter the Total Depth dimension when using the Mid-Plane option.

I Extrude 7

& R &
[from Al
ISketch Plane 'l
|pirection1 &
W IMid Plane 'l

W Merge result

@ = Mid Plane

I™ Draft outward

Condition
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- After you are done with exploring all the extrude options, change the final
condition to: Through All

EYEEEY
It Boss-Extrude
¥ R G

From

A

Direction 1 /
[_j Through Al

2.250
IS

[¥|Merge result

®

Draft outward

“:‘ Direction 2 ¥‘

[ Thin Feature v

‘ Selected Contours ¥ ‘

- Click OK ¢/).

- The system extrudes the circle to the outer most surface as the result
of the Through All end condition.

Extrude summary:

* The Extrude Boss/Base command is
used to define the characteristic of a
3D feature.

* A sketch can be extruded in both
directions at the same time, from
its sketch plane.

* A sketch can also be extruded as a
solid or a thin feature.
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13. Adding the model fillets*: e @ - (3 -fd-%-9- 8 5-
-H9-E2 | 1 @8880809 g

- Fillet/Round creates a rounded internal (g ] g diee @we o o0 [
|| Fillet | Linear % Draft e Dome | Refer;nce Curves |[Instant
3D

or external face on the part. You can Lnear Referenes
- ﬁ Shell @ Mirror - -

fillet all edges of a face, select sets - - L
of faces, edges, or edge loops. aavcemd-

face along one or more edges in salid or

;
- The radius value stays in effect until Lface o
you change it. Therefore, you can select
any number of edges or faces in the same operation.

illet
Creates a rounded internal or external

- Click @ or select Insert / Features / Fillet/Round.

Select 8 edges
on both sides

YRR EI
7 Fillet K
R
(OB roeer
Fillet Type A
(@) Constant radi
= onsant radius Radius:

(" variable radius

() Face fillet

(") Full round fillet

Ttems To Fillet ]
A\ 0.1250n s
[[) |Edge<12> -
Edge<13=
Eigecit>
Multiple radius fillet
[Muliple racus file Select 6 edges

Tangent propagation . .
P on inside walls

() Partial preview

(" No preview

“«©

|Sethad| Parameters

<«

| illet Options

- Enter .125 in. for radius value.

- Select the edges as indicated to | <

add the fillets. <

- Click OK /).

3-20



SolidWorks 2011 | Basic Tools | Basic Solid Modeling

- The resulting fillets.

Q@ SolidWorks | Fie Edt Vew Insert Took 3Dconvol window el el \D B-EH-2-9 - g = - parta * (I~ salidiorks Search I TN RO

. (3 sweptBoss/Base o _ Swept Cut @ 8 dirp [ wap W b3 S
& i @ w Filet Linear Reference Curves || 0
Extruded Revolved [} Lofted Boss/Base Extruded Hole Revolved [ Lofted cut Pt W Draft @ pome Instant30

Boss/Base Boss/Base cut  Wizard  Cut Geometry
) Boundary Boss/Base

™ soundaryCut | . . (B shel B8 miror

Features | Sketch | Evaluate | Dimxpert | Office Products | QN EMEBP-F-60- @ £- E- - A X

?Iﬁ\\\%\lﬂe =
\QPartZ

] Zensors
[A] Annetations
[32] Lights, Cameras and Scene:
3= Material <not specified>
.42 Frort Plane
3 Top Plane
%3 Right Plane
1, orign
& Extrudet
&} Extrudez

& Filet1

N R =Y

i

A

*lsometric

[R5 Model [ WMofion Study T
Solidiorks Premium 2009 Editing Part
&

Fillet

dds material
* Fillets and Rounds: (adds material)

Using the same Fillet command, SolidWorks
knows whether to add material (Fillet) or
remove material (Round) to the faces
adjacent to the selected edge.

Round
14. Saving your work: (removes material)

- Select File / Save As.
- Enter Extrude Options for file name.

- Click Save.
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Iretiony for [Teviey

Daysic Jolid /odkling

1. To open a new sketch, first you must select a plane from the FeatureManager tree.
a. True
b. False

2. Geometric relations can be used only in the assembly environments.
a. True
b. False

3. The current status of a sketch is displayed in the lower right area of the screen as:
Under defined, Fully defined, or Over defined.
a. True
b. False

4. Once a feature is extruded, its extrude direction cannot be changed.
a. True
b. False

5. A planar face can also be used as a sketch plane.
a. True
b. False

6. Equal Relation only works for Lines, not Circles or Arcs.
a. True
b. False

7.After a dimension is created, its value cannot be changed.
a. True
b. False

8. When the UP TO SURFACE option is selected, you have to choose a surface as an end-
condition to extrude up to.

a. True
b. False
. . . 3STv4 6
9. UP TO VERTEX is not a valid Extrude option. INMLe 3TV )
a. True 3Sv4°9 INdL’s
b. False 3STvd v aNdL €

3STv4 ¢ aNdL’)
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Exercise: Extrude Boss & Extrude Cut.

Dimensions are in inches, 3 decimal places.

Use Mid-Plane end condition for the Base feature.
The part is symmetrical about the Front plane.
Save your work as: Exe1-Extrudes.

BN =

250 —= r | e 250

2% 1250 —fb——F-———]--- _\
) 4% R.OZ3

1191 ]

= 1.750 ==

Origin \_, 1.000 pe—

4,000

[

2% 080 % 45° ’

e
O
\\e
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NAFTTH 4

Dasic Jolid /"\odcling

Basic Solid Modeling
Extrude & Revolve

- Upon successful completion of this lesson, you will be able to:

* Perform basic modeling techniques.

* Sketch on planar surfaces e :
* Add dimensions .

* Add geometric relations or constraints b

* Base / Boss extrudes @ )

* Cut extrudes @ .

* Create revolved features

o

* Create Fillets @ and Chamfers @ .

- The components will also be used later in an assembly to demonstrate how
they can be copied several times and constrained, to form a new assembly,
check for interferences and dynamic motion of an assembly.

- Be sure to review self-test questionnaires at the end of the lesson, prior to
going to the next chapter. They will help to see if you have gained enough
knowledge that are required in the next chapters.
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